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前言 

概述 
本文档主要描述了 DebugKits 工具的使用方法。用于帮助用户快速熟悉 DebugKits 工

具，并可以作为查询手册，明确具体特性的正确使用方法。 

产品版本 
与本文档相对应的产品版本如下。 

产品名称 产品版本 

WS73 V100 

 

读者对象 
本文档主要适用于以下工程师： 

 技术支持工程师 

 软件工程师 

 硬件工程师 

符号约定 
在本文中可能出现下列标志，它们所代表的含义如下。 
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符号 说明 

 表示如不避免则将会导致死亡或严重伤害的具有高等级风险的危

害。 

 表示如不避免则可能导致死亡或严重伤害的具有中等级风险的危

害。 

 表示如不避免则可能导致轻微或中度伤害的具有低等级风险的危

害。 

 用于传递设备或环境安全警示信息。如不避免则可能会导致设备

损坏、数据丢失、设备性能降低或其它不可预知的结果。 

“须知”不涉及人身伤害。 

 对正文中重点信息的补充说明。 

“说明”不是安全警示信息，不涉及人身、设备及环境伤害信息。 

 

修改记录 

文档版本 发布日期 修改说明 

02 2024-08-05 新增“6.2.5 串口自定义命令”章节内容。 

01 2023-12-11 第一次正式版本发布。 

00B01 2023-11-07 第一次临时版本发布。 
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1 概述 

DebugKits（以下简称 DBK）软件包是支持研发调试、现场测试等多种场景的

Windows 应用程序。 

通用功能主要包括： 

 命令行插件 

支持以命令行的方式向单板发送命令，实现对单板的查询、设置等操作。 

 消息插件 

显示单板上报的维测信息。 

 NV 浏览器 

用于修改单板中存储的配置信息。 

 System 插件 

用于支持常用维测功能。 
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2 安装 

 
 DBK 支持的操作系统版本为 Win7/Win8/Win10。 

 中文版本 DBK 在英文操作系统中显示乱码的解决方法： 

 打开控制面板，进入时钟、语言和区域（或者是时钟和区域）的“区域和语言”项（或者是

“区域”项）。 

1. 在“区域和语言”项（或者是“区域”项）的“管理”页签更改系统区域设置，将当前系统

区域设置改为“中文(简体，中国)”。 

2. 设置完成后单击确定按钮，然后重启 PC 即可。 

2.1  产品安装 

2.1 产品安装 
DBK 安装程序的安装步骤如下： 

步骤 1 双击“DebugKits.exe”打开 DBK 安装程序。 

步骤 2 弹出 DBK 安装路径选择界面，如图 2-1 所示，选择好安装路径后单击“Next”按钮。 
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图2-1 DBK 安装路径选择界面 

 

 

步骤 3 弹出 DBK 选择产品界面，如图 2-2 所示，选择对应的产品，单击“Next”按钮。 
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图2-2 DBK 选择产品界面 

 

 

步骤 4 弹出 DBK 额外任务选择界面，如图 2-3 所示，复选框勾选为创建桌面快捷方式，为方

便后续快速打开工具，建议保持复选框勾选，单击“Next”按钮。 
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图2-3 DBK 额外任务选择界面 

 
 

步骤 5 弹出 DBK 准备安装界面，单击“Install”按钮。 
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图2-4 DBK install 界面 

 

 

步骤 6 弹出 DBK 正在安装界面，请等待约 10 秒钟，直至安装完成。如图 2-5 所示。 
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图2-5 DBK 正在安装界面 

 

 

步骤 7 弹出 DBK 安装完成界面，如图 2-6 所示，单击“Finish”按钮退出安装。复选框选中

后则默认打开 DBK 程序。 
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图2-6 DBK 安装完成界面 

 

 

----结束 
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3 启动 

3.1  生成证书 

3.2  导入证书 

3.3  主界面 

3.4  切换芯片 

3.5  更新数据库 

3.6  连接设置 

3.1 生成证书 
第一次安装启动 DBK 后，界面显示需要导入证书的提示，如图 3-1 所示，工具需要在

本机导入 DBK 证书后才能使用。 
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图3-1 首次安装导入证书提示 

 

 

DBK 证书通过 LicenseTool 工具生成。LicenseTool 界面如图 3-2 所示。 

图3-2 LicenseTool 主界面 

 

 

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

深
圳
市
安
信
可
科
技
有
限
公
司



WS73V100 DebugKits 工具 

使用指南 3 启动 
 

2024-08-05  11 

 

安装并运行 LicenseTool 工具后，按照如下步骤操作： 

步骤 1 UserName（用户名）、VendorName（供应商名）、ManufacturerName（生产商名）

按照实际填写，具体值不做相关校验。 

步骤 2 LicenseType 选择“客户版”。 

步骤 3 拷贝 DBK 工具导入证书界面的机器标识码到 DeviceList 框。 

步骤 4 点击“生成 X509 证书”按钮，即可生成证书，默认保存路径为“C:\ToolLicense”。 

----结束 

3.2 导入证书 
DBK 工具需要用户在本机导入 DBK 证书文件后，方能使用。DBK 证书是两个后缀名

分别为.crt 和.key 的文件，由软件供应商提供。 

如果本机未导入证书，DBK 启动时将提示用户进行证书导入，并且在提示框中显示机

器标识码，如图 3-3 所示。此时用户需将该注册码提供给软件供应商，获取与本机对

应的 DBK 证书文件。 

图3-3 导入 DBK 证书文件界面 
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单击“Browser”按钮，同时选择.crt 和.key 两个证书文件后，单击“Import”按钮。

用户导入 DBK 证书后，可通过菜单栏“Help”→“License Info”，查看本机的 DBK

证书信息，如图 3-4 所示。 

图3-4 查看 DBK 证书信息界面 

 

 

若要放弃导入证书，可单击“Exit”。 

3.3 主界面 
DBK 主界面如图 3-5 所示，说明内容如表 3-1 所示。 
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图3-5 主界面示例 

 

 

表3-1 主界面说明 

区域 功能说明 

1 标题及连接状态。 

2 菜单栏。 

3 插件选择及连接控制。 

4 用户区，插件界面显示和实际操作区域。 

5 状态栏。 

 

3.4 切换芯片 
在连接单板之前，需要根据产品需要切换成对应芯片。操作步骤如下： 

步骤 1 在菜单栏中选择“Options”→“Change Chip”。 
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图3-6 切换芯片示意图 

 

 

步骤 2 选择需要的芯片名称并单击“确定”按钮。 

----结束 

3.5 更新数据库 
数据库（database）是板端编译过程中产生的一系列的配置文件，在板端代码的

output 目录中生成，包括多个 XML 文件和 TXT 文件。 

图3-7 数据库目录、文件概览 
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数据库的作用主要体现在两个方面： 

1. 将板端到工具方向的报文结构体化或者文本化。 

2. 将工具端结构体化的数据报文化。 

因此在连接单板之前，需要将工具数据库更新为对应产品的数据库，以便板端运行的

程序与工具端数据库一致。操作步骤如下： 

步骤 1 在菜单栏中选择“Options”→“Update HDB”，如图 3-8 所示。 

图3-8 更新数据库示意图 

 

 

步骤 2 选择数据库进行更新操作。 

1. 单击“Choose File”或者“Choose Folder”按钮，选择 fwpkg 文件或数据库文

件夹。 

2. 单击“OK”按钮，更新数据库。 

----结束 

 
 数据库可以选择产品对应的数据库文件夹或者 fwpkg 文件（部分产品已将 database 和

fwpkg 打包在一起）。 

 Choose File 可以选择 fwpkg，Choose Folder 可以选择名为 database 或 database_xxx 的

文件夹，一般的 database 文件夹会在编译后于 output 目录中生成，可以在 output 中搜索

“database”关键词查找。 

 数据库覆盖默认勾选。如果仅需要当次有效，可以通过取消勾选“覆盖数据库”选择框，不

进行覆盖操作。 
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3.6 连接设置 

3.6.1 串口连接 

在对单板进行操作前，DBK 需要先通过串口与单板建立连接。 

连接设置方法如下： 

步骤 1 打开连接设置对话框。 

在工具栏中单击“ ”或在菜单栏中选择“Connection”→“connect”或

“Settings”。 

步骤 2 完成工具配置，并通过串口连接单板。 

图3-9 连接设置示意图（串口） 

 

 

1. 选择“SerialPort”。 

2. 使用默认波特率。 

3. 选择串口。 

4. （可选）根据产品需要输入密码，对于部分无密码机制的产品则直接单击确定。

对于有密码机制的产品，提供的软件版本默认未预置密码，因此无法建立连接。

若需要设置密码，请参见产品 NV/KV 介绍文档中关于预置密码的信息。 

5. 单击“OK”按钮，连接单板。 

----结束 

 
 连接失败常见告警如下： 
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 提示“Connection failed. 4 attempts left. Check your password or cable connection.”，一

般为密码未设置、密码输入错误或连线松动等原因。设置密码请查看产品 NV/KV 介绍文档

中关于预置密码的信息。 

 提示“Your PCB has been locked. 4 s remained”，一般为之前尝试过 5 次以上输入错误密

码导致的单板锁定，请复位单板或等待锁定结束。 

 若无提示，同时也未显示连接成功，则需要排查：串口连线是否正确；支持睡眠机制的单板

是否已进入睡眠状态。 

睡眠唤醒方法请查看产品 AT 介绍文档 。 

 连接用户名固定为“admin”，无法增删改，故此处不体现。 

 若串口线断开重连后，则需要手动重新连接单板。 

 左下角复选框中“show this dialog at startup”的含义是启动时自动弹出，“show this dialog 
if click connect button”的含义是点击 connect 按钮后弹出。 

3.6.2 网口连接 

以网口连接方式连接单板需要保证 PC 跟单板在同一个局域网下，并且 PC 可以 ping

通单板的 IP。 

连接设置方法如下： 

步骤 1 打开连接设置对话框。 

通常启动 DBK 时该窗口会自动弹出。也可手动打开：在工具栏中单击“ ”或在菜

单栏中选择“Connection”→“connect”或“Settings”。 

步骤 2 使用网口连接方式 

图3-10 网口连接设置示意图 

 

 

1. 输入单板的 IP（保证 IP 可以 ping 通）。 
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2. 根据产品需要输入密码，对于部分无密码机制的产品则直接单击确定。对于有密

码机制的产品，提供的软件版本默认未预置密码，因此无法建立连接。若需要设

置密码，请参见产品 NV/KV 介绍文档中关于预置密码的信息。 

3. 单击“OK”按钮，连接单板。 

----结束 
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4 命令行插件 

4.1  简介 

4.2  主要功能及使用说明 

4.1 简介 
DBK 命令行插件（Command Line Viewer）允许用户以命令行的方式向单板发送命令，

实现对单板的查询、设置等操作。 

打开命令行插件的方法：单击菜单栏或工具栏上的命令行图标即可。如图 4-1 所示。 

图4-1 打开命令行插件示例 

菜单栏： 

 

工具栏： 
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4.2 主要功能及使用说明 

命令行查询 

命令行输入与大部分串口工具类似，输入对应指令后回车即可，此处使用的具体命令

根据产品会有差异，输入命令的首字母会出现联想列出支持的命令，请根据实际情况

填写。 

清屏 

在命令行界面按下“Shift+Delete”组合键即可。 
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5 消息插件 

5.1  简介 

5.2  主要功能及使用说明 

5.1 简介 
DBK 消息插件（Message）显示单板上报的维测信息，方便对单板进行调试及问题定

位。 

打开消息插件的方法：单击菜单栏或工具栏上的消息图标即可，如图 5-1 所示。 

图5-1 打开消息插件示例 

菜单栏： 

 

工具栏： 
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5.2 主要功能及使用说明 

5.2.1 界面说明 

图5-2 消息插件界面示例 

 

 

表5-1 消息插件界面说明 

标号 说明 

1 控制面板。其中： 

 被选中的信息将会上报。 

 未选中的信息不会上报。 

控制面板中的模块信息各产品不同，会根据当前选择的产品自动切换。

更改被选中的信息后需要点击 Message 工具栏图标 图标下发配

置。 

2 解析面板。其中： 

 左侧：该信息的十六进制字节流。 

 右侧：按结构体解析的各域的值。 

3 维测信息表格。其中： 

 NO：日志编号。 
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标号 说明 

 Category：日志类型。 

 Time：DBK 收到该信息时记录下的时间。 

 TimeStamp：单板上报信息附带的时间戳，描述的是单板打印这条信息

的时间。 

 Prim：该信息的描述。 

4 工具栏，功能请参考“5.2.3 工具栏说明”。 

 

5.2.2 菜单栏说明 

维测信息表格界面右击可以出现菜单栏，回放日志时为图 5-3，实时日志时为图 5-4 所

示。菜单说明如表 5-2 所示。 
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图5-3 消息插件界面右键菜单示例 1 
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图5-4 消息插件界面右键菜单示例 2 

 

 

表5-2 消息插件菜单说明 

标号 说明 

1 快速过滤。功能使用参考 5.2.4.2 快速过滤。 

2 清除快速过滤。 

3 清除所有过滤。 

4 过滤模板。功能使用参考 5.2.4.9 过滤模板。 

5 颜色设置。功能使用参考 5.2.4.4 颜色设置。 
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标号 说明 

6 行跳转。快捷键为 Ctrl+G。功能使用参考 5.2.4.10 行跳转。 

7 查找。快捷键为 Ctrl+F。功能使用参考 5.2.4.11 查找日志。 

8 删除列。只能删除新增列。 

9 导出选中行。 

10 导出所有日志。 

11 选中所有日志。快捷键为 Ctrl+A。 

12 复制日志。快捷键为 Ctrl+C。 

13 关闭回放文件。功能使用参考 5.2.4.6 关闭文件回放。 

14 视图。其中： 

 Tool Bar：打开/关闭工具栏。 

 Control Panel：打开/关闭控制台。 

 parser Pane：打开/关闭解析窗口。 

15 高级。其中： 

 No Format Alignment：修改 No.列的格式。 

 Show Enum Value：显示枚举值。 

 Show Prim ID：prim 列显示具体数值。 

 Combine Replay Files：合并两个 hlf 文件。 

16 打开配置界面，包括快捷键，颜色，自动保存策略等配置。 

17 冻结窗口。暂停显示后续接收的日志，解除后重新更新日志。快捷键为

Shift＋RightButton。 

18 自动滚动窗口。随着日志增加，自动滚动到最后。 

19 清空当前表格显示的日志。快捷键为 Shift＋Del。 

20 一键导出。目前只有一键导出 json 格式的功能，使用此功能时需配置

Msg.xml 文件。 
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5.2.3 工具栏说明 

工具栏如图 5-5 所示，工具栏说明如表 5-3。 

图5-5 工具栏示意图 

 

 

表5-3 消息插件工具栏说明 

标号 说明 

1 导出全部日志。 

2 打开/关闭 Control Panel。 

3 打开/关闭 Parser Pane。 

4 清除筛选模板。 

5 查找。快捷键为 Ctrl+F。功能使用参考 5.2.4.11 查找日志。 

6 设置。 

7 显示/隐藏列。 

8 打开书签列表。 

9 添加新书签。 

10 跳转到上一个书签位置。 

11 跳转到下一个书签位置。 

12 删除书签。 

13 控制面板状态改变后需要按下该按钮才能生效。功能使用参考 5.2.4.1 筛选

上报的信息。 

14 冻结窗口。暂停显示后续接收的日志，解除后重新更新日志。 

15 模糊搜索栏。对勾按钮代表开始模糊搜索。功能使用参考 5.2.4.3 模糊搜

索。 
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5.2.4 操作说明 

5.2.4.1 筛选上报的信息 

可控制单板上报信息的模块，常用于过滤某些不重要信息或仅开启重要信息上报。 

操作步骤如下： 

步骤 1 在控制面板中选中需要上报的项。 

步骤 2 单击工具栏中开始按钮“ ”，使选中状态生效（选框变绿）。 

----结束 

5.2.4.2 快速过滤 

操作步骤如下： 

步骤 1 在右侧表格中需要过滤的列处单击右键。 

步骤 2 在右键菜单中选择最上方 4 行（Quik Filter By:…）之一，即可分别过滤出该列中等于、

不等于、小于等于、大于等于该行的条目。 
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图5-6 快速过滤示意图 

 
 

----结束 

5.2.4.3 模糊搜索 

操作步骤如下： 

步骤 1 在表格上方输入框中输入需要搜索的关键词，若有多个关键词用‘|’分隔开。 

步骤 2 单击“ ”或输入回车即可在现有报文的“Prim”字段中过滤出包含关键词的报文。 
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图5-7 模糊过滤示意图 

 
 

----结束 

5.2.4.4 颜色设置 

操作步骤如下： 

步骤 1 在表格中需要设置颜色的单元格处单击右键。 

步骤 2 在右键菜单中选择“Set Color”，弹出颜色设置界面，如图 5-8 所示。 

图5-8 颜色设置菜单 

 

 

步骤 3 在 Color 页面（默认）中选择“Set Text Color”或者“Set Background Color”的颜

色。 

步骤 4 单击“OK”按钮，颜色设置效果如图 5-9 所示。 
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图5-9 颜色设置效果示例 

 

 

----结束 

5.2.4.5 表格信息导出回放 

导出 

全部导出的操作步骤如下： 

步骤 1 在表格处单击右键。 

步骤 2 在右键菜单中选择“Export All…”，弹出导出对话框，如图 5-10 所示，选择需要导出

的列（Columns）和导出的文件类型。 

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

限公司W

司WS7
3 1

.10
.11

0深
圳淇诺科技有

3 1
.10

.11
0深

圳淇诺科技有限公

0.1
10深

圳淇诺科技有限公司WS7

深圳淇诺科技有限公司WS7
3 1

.1

深
圳
市
安
信
可
科
技
有
限
公
司



WS73V100 DebugKits 工具 

使用指南 5 消息插件 
 

2024-08-05  32 

 

图5-10 文件导出对话框 

 

 

 
 当选择导出文件类型为 *.txt、*.csv 格式时，可按需选择要导出的列。 

 当选择导出文件类型为 *.hlf 格式时，对应导出的是整个数据库，无论选择某列，导出结果

均为所有列。 

 导出路径和导出文件名称都不能出现中文字符。 

步骤 3 单击“ ”，选择文件路径及文件类型（当前支持的文件类型有*.hlf、*.txt、*.csv），

并保存。 

步骤 4 如图 5-10 所示，单击“OK”按钮，导出文件。 

----结束 

部分导出的操作步骤如下： 

步骤 1 在表格中用鼠标拖拽选择要导出的单元格。选择时可以不选整行，hlf 文件类型导出时

会以整行为单位导出，其他文件类型只导出选中单元格。 

步骤 2 在选中的范围内单击右键，在右键菜单中选择“Export Items…”，弹出路径选择框。

选择保存路径及文件类型，并保存。 

----结束 

回放 

 
DBK 工具仅支持*.hlf 格式文件的回放。 

 方法 1：将文件直接拖拽到 DBK 界面中即可回放。 
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 方法 2：点击左上角菜单“File”→“Open”选择待回放的文件即可回放。 

5.2.4.6 关闭文件回放 

表格支持关闭回放的文件，具体操作步骤如下： 

步骤 1 打开本地存放的日志文件，如图 5-11 所示。 

图5-11 回放文件 

 

 

步骤 2 右键点击表格，获取到菜单列表，并选择“Close Replay File”，如图 5-12 所示。 
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图5-12 菜单列表 

 

 

----结束 

5.2.4.7 新增表格列 

新增表格列操作步骤如下： 

在“Parser Pane”右侧结构体解析窗口中，如图 5-13 所示，选择需要添加到列的成

员，右键菜单“Add item to grid”，如图 5-14 所示。 
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图5-13 Parser Pane 示意图 

 
 

图5-14 添加到列菜单示意图 

 
 

5.2.4.8 自动保存 

实时消息支持自动保存，操作步骤如下： 

步骤 1 单击右键，在菜单中选择“Configure”，弹出设置界面。 

步骤 2 在设置界面中选择“Save”窗口，如图 5-15 所示。 
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图5-15 设置界面 

 

 

步骤 3 （可选）勾选“Custom Path”，并选择路径。 

步骤 4 （可选）在“Advanced Options”中根据需要勾选“Setting Replay File Size”设置每

个文件的大小和“Total Files Limitation”总文件个数限制。 

步骤 5 单击“OK”按钮。 

----结束 

5.2.4.9 过滤模板 

表格信息过滤支持过滤条件保存和使用，具体步骤如下： 

步骤 1 根据需求可以进行模糊搜索（具体操作请参见 5.2.4.3 模糊搜索小节），结果如图 5-

16 所示。 
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步骤 2 根据需求可以新增表格列（具体操作请参见 5.2.4.7 新增表格列小节），结果如图 5-

16 所示。 

图5-16 模糊过滤和新增表格列结果图 

 

 

步骤 3 单击右键，选择“Filter Template”→“Save Filter Template”，如图 5-17 所示。 

图5-17 保存过滤条件 

 

 

步骤 4 输入需要保存过滤模板的名称，单击“Save”按钮，保存过滤模板，如图 5-18 所示。

可以重复步骤步骤 2~4，通过命名区分保存多个过滤模板。 
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图5-18 过滤模板命名 

 

 

步骤 5 单击右键，选择 Filter Template → Open Filter Template，如图 5-19 所示。 

图5-19 打开过滤模板 

 

 

步骤 6 然后通过之前保存到过滤模板名字选择需要的过滤模板，如图 5-20 所示，单击

“Apply”按钮，界面会显示过滤后的内容。 

图5-20 选择过滤模板 

 

 

----结束 

 
过滤模板仅支持模糊过滤，不支持快速过滤。 
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5.2.4.10 行跳转 

表格支持跳转到某一行，具体操作步骤如下： 

步骤 1 右键点击表格，获取到菜单列表并选择“Go To Item...”或者使用快捷键 Ctrl+G。 

步骤 2 填写跳转至哪一行并点击 OK，如图图 5-21 所示。 

图5-21 行跳转界面 

 

 

----结束 

5.2.4.11 查找日志 

 
Find 功能搜索大日志量时效率较低，建议使用模糊搜索功能。 

表格支持查找日志，界面如图 5-22，功能介绍参考表 5-4。 
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图5-22 查找日志界面 

 

 

表5-4 查找日志界面说明 

标号 说明 

1 查找的起始位置，数字为当前选中行。 

2 查找的内容。 

3 时间。查找从一个时间到另一个时间的内容。 

4 时间戳。查找从一个时间戳到另一个时间戳的内容。（ms 为单位） 

5 列名。查找所选列的内容。 
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标号 说明 

6 仅整个单词匹配。 

7 匹配大小写。 

8  Find Count：查找到的行数。 

 Row Count：总行数。 

9  Cancel：停止并取消查找。 

 Find：开始查找。 

 List：显示/关闭查找列表显示区。 

10 查找列表显示区。 

 

查找日志操作步骤如下： 

步骤 1 右键点击表格，获取到菜单列表并选择“Find...”或者使用快捷键 Ctrl+F 或者点击工

具栏 按钮，打开查找界面。 

步骤 2 配置查找参数。 

步骤 3 点击 Find。 

----结束 

5.2.4.12 帧解析 

某些报文支持 wireshark 进行解析并显示在表格中，如图 5-23 所示。 
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图5-23 帧解析报文 

 
 

解析报文步骤如下： 

步骤 1 安装 Wireshark 到 C:\Program Files\Wireshark 路径下，版本使用 Wireshark-win64-

3.x（最低版本为 Wireshark-win64-3.4.11）。需要解析的报文将会显示其解析内容。 

步骤 2 修改 pcap 文件打开方式，使用 Wireshark 打开。在 windwos 中右击任意 pcap 文件，

依次点击“属性”→“常规”→“更改”选择“Wireshark”。 

步骤 3 双击可解析的报文，会用 Wireshark 打开。 

----结束 
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6 System 插件 

6.1  简介 

6.2  主要功能及使用说明 

6.1 简介 
System 插件主要包含常用维测功能。 

打开 System 插件的方法：如图 6-1 所示，单击菜单栏或工具栏上的 System 图标即可。 

图6-1 打开 system 插件示例 

菜单栏： 

 

工具栏： 
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6.2 主要功能及使用说明 

6.2.1 内存读取 

内存读取功能用于将设备中一段内存保存到计算机指定文件中。 

图6-2 内存读取界面 

 

 

表6-1 内存读取说明 

标号 说明 

1 单击“...”选择文件。 

2 设置参数。 

 Address：内存读取起始地址（16 进制）。 

 Data Length：内存读取数据长度（一般为 10 进制，若 16 进制

请在前面添加 0x，输入数据应为 4 的整数倍） 

3 内存读取开始按钮。 

4 内存导出进度条。 

 

操作步骤如下： 
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步骤 1 在“Save To”中选择需要保存的路径。 

步骤 2 设定参数。 

填写“Address”、“Data Length”。 

步骤 3 单击“Read”按钮。 

设备中读取出数据保存到“Save To”填写的路径中。 

----结束 

6.2.2 寄存器控制 

RegisterControl 界面主要用于寄存器的读写。 

图6-3 寄存器读写功能主要界面 

 

 

6.2.3 数据采集 

Data Collection 界面主要用来接收单板业务上传的数据，并将数据保存。 
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图6-4 Data Collection 主界面 

 

 

表6-2 Data Collection 界面说明 

标号 说明 

1 保存路径选择区。（开始后“Start”按钮会变更为“Stop”按钮） 

2 参数选择区。 

 

数据采集的步骤如下： 

步骤 1 在参数选择区选择合适的数据采集参数。 

步骤 2 在保存路径选择区点击“...”按钮，在弹出的框中选择要保存的路径。 

步骤 3 点击 Start 按钮，开始数据采集。 

步骤 4 采集完成后结束采集（点击“Stop”按钮也可结束），将会在要保存的路径下生成对

应个数的 bin 文件。 

----结束 

6.2.4 Psd 
Psd 界面主要是频谱图的显示。 
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图6-5 Psd 主界面 

 
 

表6-3 主界面说明 

标号 说明 

1 界面开启按钮。 

2 采样周期设置。 

3 采样时长设置。 

4 数据导出按钮。 

5 频谱图显示区域。 

6 频率范围。 

 

频谱图打印步骤如下： 

步骤 1 选择采样周期，采样周期范围为 100ms～1000ms。 

步骤 2 选择采样时长，最低采样时长为 1min。 

步骤 3 点击 Start 开始绘图。 

----结束 
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6.2.5 串口自定义命令 

本界面主要根据界面上的参数拼接命令通过串口下发到单板，适用于参数复杂或命令

繁多的命令拼接下发场景。 

图6-6 UARTRawData 主界面 

 

 

表6-4 UARTRawData 界面说明 

标号 说明 

1 配置收发数据的端口号。 

2 配置收发命令的波特率等串口常用的参数。 

3 选择收发命令展示区显示内容 

4 当命令是由多条组成时，设置命令发送的间隔 

5 字符串搜索框 

6 配置需要收发命令的参数。 

7 自定义命令发送 

8 收发命令展示区。绿色字符为串口接收数据，黑色字符为串口发送数

据。 
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收发命令的操作步骤如下： 

步骤 1 选择要收发命令的端口和对应的波特率。 

步骤 2 单击“More”设置串口参数，单击“open”打开端口。 

步骤 3 选择需要发送的命令对应的 group。 

步骤 4 按照需要，修改对应 group 中参数值。 

步骤 5 单击目标 group 的“Write”按钮；在收发命令展示区查看具体发送的命令和收到的串

口数据。 

----结束 
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